aap Implantate AG

Excellence in Innovation

Information Memorandum
September 2023




Safe Harbor Statement

Our publication may include predictions, estimates or other information that might be
considered forward-looking. While these forward-looking statements represent our current
judgment on what the future holds, they are subject to risks and uncertainties that could
cause actual results to differ materially. You are cautioned not to place undue reliance on
these forward-looking statements, which reflect our opinions only as of the date of this
presentation. Please keep in mind that we are not obligating ourselves to revise or publicly
release the results of any revision to these forward-looking statements in light of new
information or future events. Throughout today’s discussion, we will attempt to present
some important factors relating to our business that may affect our predictions.
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Executive Summary qu
)

Investment highlights

@ ‘:O Expanding strongly in the US-market with its
A\\ trauma portfolio since 2019 and poised for
. . . continued growth striving for profitable growth with - A /
fl Pure player in trauma with its significantly improved bottom-line ,/“f W
. patented LOQTEQ® Technology ) AT
(orthopaedic fixation), which will serve B A

as the exclusive incubator for our
antibacterial silver coating technology B N

4

v )
@ ® D ®
/]

REVOLUTIONARY | b ©

8 2

ZEN INNOVATIVE
Management Team has built a robust and ; \ L - K AT Front runner in antibacterial silver
agile Organization, ready to take off in the [ g TR 55 e coating technology that dramatically
trauma business and built the base for its ‘ " &4 were  reduces surgical site infections (SSI);

game changing antibacterial silver coating tackling one of the growing issues in
technology healthcare with >30% of all orthopaedic

trauma cases leading to infections; aap’s

/ \ solution being “at the bed of the patient”

uP Exciting investment opportunity in a highly innovative and
K / clearly undervalued MedTech company with great value
Market-Data creation potential

F P/5:0.7x
» PE: NA
- P/B:0.8
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Executive Summary

Unmet need: Simplify

operation techniques

Our answer: Comprehensive portfolio
with patented unique screw-plate
locking technology with great expansion
potential and 10 years proven clinical
track record

Innovative and game-changing product portfolio

Unmet need: Reduce surgical
site infections (SSI)

Our answer: Unique patented Silver
coating technology (human clinical trial
ongoing) preventing  bacterial
colonization on trauma implants and
actively destroying infections around
the implant with excellent
biocompatibility, high stability and
antibacterial efficacy results

Silver Coating
LOQTEQ

Unmet need: Avoidance of

second operation (explantation)

Our answer: Unique patented
magnesium alloy and coating technology
(in R&D phase) with a wide range of
applications (e.g., extremity and facial
surgery, sports medicine or pediatrics)

Further development on hold - lacking

financial resources

mp Platform Technologies addressing unmet needs in trauma
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Executive Summary

Experienced management team continuing to drive forward transformation & profitable growth

>

>

Rubino Di Girolamo
CEO

CEO since 2019

With aap as investor since 2004 and
Board Member

Long-standing experience in different top
management positions e.g., at Metalor
Dental Holding AG, Bellevue Group and
Saurer Group

Graduation (M.A.) in Economics at the
university of applied science, Ziirich
(ZHAW)

Agnieszka Mierzejewska
coo

COO since 2021

Since 2014 with aap in various leadership
roles

Working in different operational
positions for medical device & patient
care companies e.g., Vanguard AG,
Active in various networks, with latest
publication on need for antibacterial
solution

M.A. in Health Economics and Health
Management at Fresenius Univ. Cologne

aap Implantate AG
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Executive Summary

Targets 2023

Starting position 2023

» Massive reduction of cost base since 2019 compared to 2022
Sales increased by ~4%

—  Upto-50 % manufacturing cost
—  -16 % Personnel (reduction overstaffing)
—  -25% OPEX (reduction “Holding” cost)

»  Build-up sales force in Germany by end 2022,
US-Team enlarged, ready to perform in 2023

»  Patent based R&D investments in
— LOQTEQ® > € 50m
—  Silver coating technology > € 15m

—  Magnesium technology > € 3m

»  Trauma product registration for markets CE, FDA, NMPA
(China), SFDA and many more.
Investment value > € 2m

>  Solid relation with notified body DEKRA, passing all audits
since end 2020 with good results, FDA 2022 passed with no
remarks.

»  MDR transition on track, Investment value > € 2m

»  Meet increasing compliance regulations (on track), as e.g., ESG
concept, Supply Chain Due Diligence Act,
(Lieferkettensorgfaltspflichtengesetz )

Leads to

Main target
2023

Revised targets 2023

> Restructuring Program

Implementing cost measures to save € 1m - € 2m p.a. to
adapt to short-term achievable sales target level of € 12m -
€15m.

» Human Silver Study

— Re-Start human study with new approved and released
protocol successful and as planned

— End of August 39 patients included in the last 3 %2 months
— Target to achieve 150 patients by year-end

— Continue with successful compassionate use cases in
Germany

— BMBF confirmed extension financial support of the
personnel cost till 2025 with additional € 0.4m

> Sales
— Growth target USA: 10%- 15 %
— Growth target EMEA: 0% - 5%
— Growth target LATAM: 10% - 15%
» MDR-Path

— MDR readiness achieved, waiting for time schedule
notified body (since 2022)

aap Implantate AG
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Executive Summary

Restructuring 2023

Starting position 2023

Conclusions 2023

Markets not producing planned growth. Growth areas are almost

»  Restructuring 2020 aimed to sustain growth up to € 20m. neutralized by declining areas.
Starting to become profitable with sales of € 15m.
> International: shows great opportunities but
»  The first target line € 15m sales was planned to achieve in increasing regulatory hurdles slow down the boarding
2022 of new customers or extending the portfoliosin
—  The worst economic situation since 2020 prevented existing markets
the chance to achieve this goal Leads to >  USA: large growth potential could not yet be fully
—  Therecovery in 2021 with becoming profitable exploited
collapsed in 2022 with the perfect storm be it in the Restructuring >  Germany: hovering around the 2020 level, starting to
stock/financial sector, be it in the international conclusion grow in small steps
business sector, be it in Germany 2023
> Group: regular sales of € 2.6m - € 3.5m per Q, with an

—  Consequently, the target was missed by far and led to
liquidity shortage to be covered.

average close to € 3m per Q

[.u

Conclusion: Markets not delivering the anticipated growth and
hence missing operative profitability/cash flow—> cost structure
needs to be adjusted to the yet sustainable turnover of € 12m
with an upper range of € 15m.

aap Implantate AG 8



Executive Summary

Cash needs and your investment opportunity

Financing needs

LOQTEQ®/ Restructuring ~€ 1.0m

> Operative financing
> Restructuring program

Silver technology ~€0.4m

» Net financing need for conducting
human clinical trial study (after
funding by BMBF)

Financing ~€0.75m

> Pay back bridge loans 2020/2022,
Leasing (incl. IFRS16 payments)

Convertible bond € 2.7m

Potential round 2024 to be defined by progress on
silver study, infrastructure and effect of the
restructuring measures.

Massive upsides stemming from the
exclusive silver coating technology
(USP world-wide).

The Company is poised to grow in
its core business.

Management showed strong
performance going through a
“perfect storm” restructuring,
Covid-19, inflation, energy and war!

A planned public convertible bond
for existing shareholders, gives the
opportunity to acquire a
participation due to limited market
liquidity.

aap Implantate AG
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Executive Summary

Targets 2024 - 2031

Targets 2024 - 2026

Base for doing business

>

>
>

New trauma products released (MDR, FDA already released
and new ones in progress)

Site moved from Lorenzweg 5, Berlin to a new site

IT overhaul to new standard (cloud) and ERP upgrade

Silver coating technology

»  Silver MDR registration received for aap trauma products

»  Silver coating production line active

»  Silver registration in China through aap China and USA/FDA in
process

>  Partnering with 3™ parties with aap Silver unit (MCTeQ GmbH)

Trauma Line

»  Sales level achieved € 20m

»  Production unit highly automized

»  Trauma silver portfolio in its build-up phase

Targets 2027 - 2031

Sales including trauma silver portfolio

» Increase sales by 2031 > € 50m with much higher potential if
it’s proven to be the new gold standard in trauma.

Silver coating unit

»  Achieve China/Asia registration for the trauma silver line
»  Achieve FDA registration for the trauma silver line

>  Achieve 3" parties' registrations and production of the
products as a service; can start earlier if 3" parties are seeing
the results of the trauma human study and the compassionate

Leads to

. use results.
Business Base '

2027-2031
Alternatives

> Partnering or selling non-trauma silver licence to 3" parties

» M & A with larger industry corporations and become a
dedicated product silver line

aap Implantate AG
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Executive Summary

aap stock clearly undervalued in peer group comparison

Market-Data
> P/S:0.7x
> P/E: N.A.
> P/B:0.8

S-DAX: Small Cap Healthcare shares since fall 2021 under pressure in a “perfect storm”*

i W N R

Phase August 2022: gap had to release an ad-hoc to lower its outlook 2022 on sales

—®

GLOBUS

MEDICAL

medartis®

PRECISION IN FIXATION

Medactg

International

Phase February 2022: start of war in Ukraine leads to “risk-off” actions and sell off of small cap company shares

Phase April 2022: accelerating interest hike dynamic by central banks brings the valuations further under pressure

discussed to bring the share price above the mandatory € 1 minimum price for any capital transaction

Data based on own calculations // *Bellevue HY report 2022

Market-Data
> P/S:3.5x
> P/E:26.33
> P/B:3.5
Market-Data
> P/S: 6.0x
> P/E: N.A.
> P/B:6.0
Market-Data
> P/S:5.9x
> P/E:44.23
> P/B:7.6

Phase September 2021: Upcoming inflation fears, first “tapering” steps US FED leads to growth fear and brings small caps under selling pressure

Phase Q2 2023: due to the above price erosion and the very small free float and therefore very low liquidity in aap share, a capital cut was

aap Implantate AG
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Trauma Business uu

What clinics typically want when purchasing implants

Quality and functionality

» Quality has different dimension (e.g., strength, surface structure, bio-compatibility, no cold welding when tightening
screws etc.) but while it is still an absolute must, it’s fair to say that many suppliers do fulfil the basic quality criteria today.

» Functionality is therefore an increasingly relevant criterion — e.g., the number of screws to fix a plate or the way to tighten
it and thereby simultaneously fulfill compression and fixation influences quality and in time of the surgical intervention
which impacts the economics of the clinic.

I:> aap excellently positioned given its high-quality plate and screw systems.

Portfolio

» Given that screws and plates of different suppliers do not fit together a clinic typically purchases one or very few systems
from vendors in order to minimize complexity and the time needed to train surgery teams to use the systems.

» Range of portfolio is therefore a key decision criterion which favours large incumbents covering all components. Still, there
remain specialists with niche portfolios (e.g., Paragon 28 for foot and ankle joint)

I:> aap covering 90% of major trauma indications but still has certain gaps in the portfolio which are being addressed.

Consignment stock

» Industry standard is to provide fully equipped trays with implants to clinics / hospitals in consignment. The customer only
pays used implants as trays are replenished.

» Provision of consignment stock is a significant burden impacting working capital and thereby favouring financially strong
companies.

I:> one of the reasons why aap is seeking further capitalization.

aap Implantate AG
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Trauma Business

aap's answer: Differentiated and broad aap LOQTEQ® trauma portfolio

Technology Key Achievements

v' Unique technology with comprehensive patent protection

)ne Hole
v' Portfolio covers today > 90% of major trauma indications

v' 4 patent families that place strong demands on the design and
} : # fixation technology of the LOQTEQ® system
"3}

=) 7 v' Superior biomechanical properties** compared to the market

Upper

A Lower ‘ ﬁ Extremities benchmark
. .pe . . . % p
v Fracture compression and angular stability in one surgical J\l 5 ! ( = 50
J ]
s, N 3 maap |

Competitor

step 700
600

v' High stability through the combination of two fixation

400

Dynamic breaking load [

principles g
» Cone connection ‘ 5/’

» Circumferential thread

300

v’ Easy explantation - no cold welding* 200

0/3/,9( NN NN NN A N
@

| & 4 | 100
v Anatomical design with optimized fit and predetermined ‘éidf I,* { .
0 4 s » & & 2 » 3 &
screw angles for improved fracture fixation 73 *23 & & & §F &S § S
& F & S & & & & & & FF L L
v Locking & compression in ONE step . TS ESTT ISy S SE
+ ;,-‘-'Q < Q\‘} ;t* & <9 & q q & Q\‘f
G
Comprehensive Portfolio Platform Technology Adressing Trauma Challenges Added Value '
Covering most common fracture patterns LOQTEQ® Technology for broad range of applications'  Solutions for elective and periprosthetic factures Through IP-protected techr:jologles adressing
unmet needs

. . ) . . : . . : i .
rl S L - .
Please refer to biomechanical study ,Locking design affects the jamming of screws in locking plates”, Injury, Int. J. Care Injured 4951 (2018) S61-S65 aap Implantate AG 14

*%*Biomechanical tests with the Institute of Biomechanics of the BG Clinic Murnau.
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Trauma Business

LOQTEQ® technology has tangible benefits for patients and surgeons...

»For me, efficient and successful treatment of the
patient is paramount. Thanks to the LOQTEQ®
Osteotomy System, | have the possibility to treat my
patients with a shorter and at the same time more
stable HTO plate to prevent possible soft tissue
irritation and thus enable earlier mobilization.”

Dominik Pelivan

Prof. Wolf Petersen, M.D., Chief of Orthopedics and
Trauma Surgery at Martin Luther Hospital, Berlin,
Germany

Midfielder at FC Energie Cottbus®

*Central defender at FC Chemnitz (season 21/22)

"It was important for me to be
able to return to competitive
sports as soon as possible. Already
7 weeks after the surgery | was
able to do sports without crutches
again, after about 13 weeks | could

® participate in soccer team training.
»The LOQTEQ® Femur PP System offers us trauma it marimpraschymtedret

surgeons the possibility to treat our patients with absolutely free of complaints, so
periprosthetic fractures of the femur safely and stably, Eﬂztfﬂfttzg‘liitg‘;ﬁ;r;;he waly af
despite the presence of a prosthesis. Thanks to the 05.02.2023."

additional hinges, which can be variably adjusted up to

45 degrees, with angle-stable screws that can be used

polyaxially, we achieve the desired results in

these complex osteosynthesis procedures.”

Prof. Dr. med. Sven Mardian, Senior Consultant, Section Head
Trauma Surgery and Musculoskeletal Tumor Surgery, Berlin,
Germany

»The LOQTEQ® Osteotomy System allows optimal
care and adaptation to the increasing indication for
corrective osteotomy while providing a clear set of
instruments. In particular, the option for angular
stable fracture compression makes osteotomy easier
for me and can shorten the operating time.“

Prof. Dr. med. Sven Scheffler, specialist in orthopedics and
trauma surgery, partner of the Sporthopaedicum clinic,
Berlin, Germany

,»The LOQTEQ® Femur PP System
is beneficial for the treatment of periprosthetic
fractures. In particular, it increases flexibility in
bicortical screw placement, thanks to the polyaxiality
of the lateral hinges and the superior stability of the
plate.”

PD Dr. med. Clemens Koésters, Chief Physician at Maria-
Josef-Hospital Greven, Specialist in Orthopedics,

Specialist in Special Trauma Surgery and European

Specialist in Traumatology (Fellow European Board of
Surgery/FEBS Traumatology) -~

.‘
g .
oS
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Trauma Business
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aap revenue development 2018 — 2024 (E)

Market development pipeline

Sales Development 2019- 2024

’ kEUR (only trauma)
' s 20
P _.="
CAGR+6% . .= =" "
’ T CAGR ~4%
—
10

access planed 2023 access planed 2024
(registrations/ tenders in process/ started)

B Further market penetration

(=] w

2021 2022 2023 (E) 2024 (E)

mEMEA mUSA direct m USABD m LATAM m APAC m Discontinued Portfolio - add on

CAGR market = P> CAGR aap

CUsD — USA direct (only)* z
o
6.000 :
=}
8
5.000
CAGR ™ +20—25% - 0]
=
4.000 o
=
g
- =
o
3.000 &
o g
2
2.000 2
»
@
1.000 ]
(@]
0
Q
3
2019 2020 2021 2022 2023 (E) 2024 (E) o

*Growth w/o set sales/one-timer

v Growth overall ~+6% above projected market CAGR of global trauma upper and lower extremities at ~4%**

v' Direct US Business: to grow from 16% to 35% revenue share from 2018 — 2024(E), ongoing expansion of sales agent network and higher priced case value
setting base for driving profitable growth; per HY1/2023 at 31% revenue share

v’ Europe: with stronger market penetration to sustain solid sales (Germany, Spain/Portugal) and expand in further European markets (e.g., France); strengthen

presence as German manufacturer

v’ Rest of the World: despite challenging micro- and macro economics resilient distributor base and initiation of product and regional expansion; profiting from
aap’s understanding of comprehensive support on all levels and high-quality products

Strong customer retention
77% of customers stay with aap > 5 years (Direct sales to clinics through
contract base to purchasing organizations/ clinic groups) v

BEE= 56% of customers stay with aap Inc > 3 years (growing legacy sales agent v
= base combined with constant expansion)
- 53% of customers stay with aap 2 5 years (resilient distributor base, in some v

regions large organizations using aap to complete trauma product range)

*Impact COVID-19 on business operations due to lock-down periods.

International and national registrations
aap’s product portfolio approved in core and emerging markets

CE MDD approval certificate valid with transitional period until 2028; MDR
transition in progress

Full aap portfolio US FDA (510 (k) clearance with growing pipeline in progress
(new product registrations ongoing)

NMPA (China), ANVISA (Brazil), SFDA (Saudi Arabia) and many other registrations
assigned

**Global Trauma Fixation Device Market Insights, Forecast to 2025, page 15.

Strong training and service platform

v

v

Increased training and sales platform in various forms to facilitate distributor
and end user support; increasing attractiveness as manufacturer

Broadened portfolio of products enabling winning of new customers (growth
potential for ex/EU customers to gain new business and accelerate)

Core competencies from R&D, PM and Sales in-house to ensure professional

high level of servicing

aap Implantate AG 16



Trauma Business

Road to success in trauma business

Key Drivers:

Operational leverage

Strong focus on developing
and managing sales channels

Changed management
and performance culture

Continuous product &
portfolio development

Goals:

v

v

Continuous improvement of gross margin through operational efficiency
programs and economies of scale

Targets sustainable sales growth and profitable operative EBITDA in 2024

Accelerating top-line growth with LOQTEQ® > €20m by 2027

Further intl. registration coverage and distribution with focus on
growing markets (e.g., US, SEA)

Strong emphasis on training and market penetration

Efficient and competent organizational excellence

Culture of performance and quality

Expansion of IP-protected platform technology LOQTEQ® to
complete full trauma range

Launch LOQTEQ® antibacterial product line with unique portfolio
position in trauma

aap Implantate AG
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Antibacterial Silver Coating Business

“Game-Changer” for medical device industry

Unmet Need

Biofilm formed on an TiAl6V4
implant surface

Healthcare-associated infections (HAI)
are one of the major challenges in
medicine

3.2 million people are estimated to
receive an infection diagnosis every year
in Europe, of whom approximately
37,000 become fatal”

leads to 16 million extra-days of hospital
stay, and an annual cost of approximately
€ 7 billion across Europe™

In orthopedic trauma, it has been
estimated that up to 30 % of cases may
result in infection™”

Antibacterial
Silver Coating
(fusion) by
aap

v’ Pioneer in the development of an
antibacterial silver coating technology for
trauma implants

v' Platform technology with wide potential
applications (cardiology, orthopedics, etc.)

v’ Stable coating (fusion) with high
antibacterial efficacy and biocompatibility

v’ Cost-effective coating technology

v Conducting worldwide first clinical study of
its kind

v’ Strong and comprehensive patent portfolio

v" Enormous market potential

*European Centre for Disease Prevention and Control, Economic evaluations of interventions to prevent healthcare-associated infections — Literature review. Stockholm: ECDC, 2017.
**World Health Organization, Report on the Burden of Endemic Health Care-Associated Infection Worldwide - Clean Care is Safer Care. WHO 2011.
***Schwarz et al., 2018 International’Consensus Meeting on Musculoskeletal Tnfection: Research Priorities from the General Assembly Questions.

Journal of Orthopaedic Research 37(5): 997-1006, 2019.

aap Implantate AG
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Antibacterial Silver Coating Business

Wide range of applications

Silver Coating Technology

Trauma

Plates + screws Cannulated screws Nails

aap
LOQTECQY

O Locking Compression Technology by aap
Hi

External fixation

v Wide range of applications
outside trauma

v’ Co-development and licensing
deals with global medical device
companies.

v’ Operating a coating center for
licensee

|:| v' Successfully coated

Recon

Hip prosthesis

Hip prosthesis
Knee prosthesis
Extremities

\l/

Other

Cardiovascular

Spine

Dental

Surgical
instruments

VET

Potential to reduce infection rates in a wide variety of applications and the overall amount of antibiotics required for treatment!

aap Implantate AG
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Antibacterial Silver Coating Business

LOQTEQ" path to registration

antibacterial

LOQTEQ® Antibacterial Distal Tibia
& Fibula Plate 3.5 System

Process

| 1
Cleaning process Coating process
] ]

v Process design

v Reproducibility

v Equipment
qualification
v’ Cleaning process
validation

v’ Process Risk Management
v  Process Validation

v’ Process design
v' Reproducibility

v Equipment
qualification

v’ Coating process
validation

i i i i i
Biocompatibility Shelf life Mechanical Other processes
safety
L 4 A4 A4 v A

v’ Cytotoxicity

v Irritation

v Sensitization

v’ Acute systemic toxicity

v’ Genotoxicity

v’ Pyrogen test

v Subacute systemic
toxicity
v Local effect after
implantation

¥ Pharmacokinetic

v Chronic systemic
toxicity

v In-vitro v Accelerated aging v’ Biomechanics v’ Packaging
v Infection model v Real time aging v Corrosion v Sterilization
v Release profile v Coating adhesion v Transport

v Fracture healing*
PR S l

I Clinical Evaluation

v" Since May 2021: 100% successful compassionate use
cases (6) in Germany with excellent healing, fast
reduction of inflammatory activities and smooth and
complete wound healing (tibia distal & proximal,

humerus plates), no signs of toxicity  Design Risk Management

v’ Design Verification
Design Validation (Clinical investigation in human still needs to be completed)

* Comparison of bone healing between antimicrobial silver-coated locking plates vs. uncoated locking plates —
An experimental study in a rabbit humerus midshaft osteotomy model
(GLP Study No: C-Silcoat 114112)

@ AO Foundation

aap Implantate AG
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Antibacterial Silver Coating Business

LOQTE

antibacterial

Y Market study — Human Clinical Trial

Clinical Need Study Objectives

» In general, surgical treatment of
fractures in orthopedic trauma patients
is at risk for implant-associated

infections

» The silver-coated plate is designed to
prevent bacterial colonization on the
implant surface and to kill resistant
bacteria with high efficacy

» Product used in Human
Clinical Trial focused on
on lower extremity —
due to high incidence

in infections

» To show the safety of the LOQTEQ®
antibacterial silver-coated system is
non-inferior in comparison with the
uncoated LOQTEQ® system

» To show the clinical benefit of the
LOQTEQ® antibacterial silver-coated
system in comparison with the
uncoated LOQTEQ® system

» To recruit 292 patients in ~1,5 years
followed by 12 months follow-up

» To support regulatory approval
processes in Europe, USA and Asia

Qap

SPONSORED BY THE

* Federal Ministry
R of Education

and Research

The German Federal Ministry of Education
and Research (BMBF) is acknowledged for
funding this research as part of the program
" Transferring medical solutions into patient
care - Proving clinical evidence without
delay" (funding codes: 13GW0313A,
13GW0313B, 13GW0449A and
13GWO0449B).

aap Implantate AG 22



Antibacterial Silver Coating Business

LOQTEQ. Market study — Human Clinical Trial

antibacterial

Updated Study

Design

Randomized, controlled, subject-blinded, multi-center study of LOQTEQ® antibacterial locking plates in subjects
with fractures of the distal fibula (AO type 4F3 injuries)

» Primary Objective: To show the safety of the LOQTEQ® antibacterial silver-coated system is non-inferior
in comparison with the uncoated LOQTEQ® system.

> Secondary Objective is to show the clinical benefit of the LOQTEQ® antibacterial silver-coated system in
comparison with the uncoated LOQTEQ system.

» 292 subjects with either Investigational (coated) device or Comparator (uncoated) device

» 12-month Follow-Up period

» Clinical trial period: Restart with new design Q2/2023 until 2025 Plate
Restart Clinical Trail Submission CE (MDR)
2023 2024 2025 2026
I
B=d=)c)dedo)ud)ade ) ode |
l /| /| | | |
Initiations and Recruiting Phase Follow-up Phase Data cleaning /
Re-Training of (12 months) (12 months) analysis
sites (3 = 6 months)

Distal Fibula

Qap

SPONSORED BY THE

% Federal Ministry
& of Education

and Research

The German Federal Ministry of Education
and Research (BMBF) is acknowledged for
funding this research as part of the program
" Transferring medical solutions into patient
care - Proving clinical evidence without
delay" (funding codes: 13GW0313A,
13GW0313B, 13GW0449A and
13GWO0449B).

aap Implantate AG 23



Antibacterial Silver Coating Business

LOQTEQ. Market study — Human Clinical Trial

antibacterial

Qap

SPONSORED BY THE

Timeline and costs of clinical study

Timeline

% Federal Ministry
4 of Education
and Research

The German Federal Ministry of Education

and Research (BMBF) is acknowledged for
Number of | Number of | Inclusion rate Restart of End of End of funding this research as part o the program
ransterring meadical solutions into patien’
subjects centers per centers recruitment recruitment study care-P(roving clinical evidence without
delay" (funding codes: 13GW0313A,
Fibula indication 292 12 2 per month Q2/23 Q2/24 Q2/25 Howos1se, 13GW0449A and
Actual status
31.08.2023 Num-ber of Number of Inclusion rate 1st. patient En.d of End of
subjects centers per centers recruitment study
2,6 per month
. e 10 (active with avg. 4
Fibula indication 39 ( ) & 16.05.2023 Q4/24 Q4/25
(15 planned) centers
(excl. ramp-up)

Planned Costs

Wi

Costs Funding
Funding for the period of: (to be prefinanced on a | (following Quarter aap’s costs net*
quarterly basis) flow back)
Q3/2023 - Q4/2025 3.600.000 € 1.800.000 € 1.800.000 €

*not including the silver R&D team activities and not covered personnel cost

aap Implantate AG 24



Antibacterial Silver Coating Business

Qap

LOQTEQ Compassionate use case - “Game changing technology” in action

antibacterial

Case extract Trauma Center Hamburg, Germany

» Ukrainian young soldier, severely injured during combat in Ukraine in May 2022

» Admission to German hospital (06/2022) with wound healing disorder after shrapnel injury
with external fixator in place

» Microbiological evidence of 4-MRGN Pseudomonas aeruginosa (antibiotic resistance), etc.

» Supply (09/2022): Angular stable plate osteosynthesis using silver-coated LOQTEQ® tibial
plate as part of individual healing trial*

» Result: X-rays 6 weeks and 8 months postoperatively show incipient and progressive bony
consolidation. Overall irritation-free skin soft tissue and scar conditions.

Réntgenbilder (anterior-posterioi (Ap) sowie lateral (lat.)) unmittelbar nach offener Repositionierung mit winkelstabiler
Plattenosteosynthese sowie 6 Wochen und 8 Monate postoperativ zeigen beginnende und voranschreitende knécherne
Konsolidierung.

LOQTEQ antibakterielle Tibiaplatte 3.5 der Firma aap in OP-Vorbereitung sowie intraoperativ in sitiu

im Sep. 2022 sowie im Verlauf 4 Monate postoperativ

am linken U

* Individual therapeuticttrialsTareusedimexceptionattases when there is no (more) standard treatment; the decision is up to the physician and patient after a precise clarification of all

alternatives as well as a well-founded explanation, see reference https://www.med.Imu.de/einrichtungen/ethik/individueller_heilversuch.pdf

Surgeons’ feedback

»| can only confirm the colleague [Prof.] Alt: | also saw an
excellent healing process during my operation and could no
longer detect any infection activity after ten days,” [...]

»If the results are confirmed in the upcoming human clinical
study, | see a good chance that such a technology has the
potential to become the market standard.”

oy

Dr. med. Rene Burchard, head physician at the Clinic for
Orthopedics & Trauma Surgery at the Dill Clinics in
Dillenburg, Germany

,Here, there was a desired significant increase in the local
silver concentration in the wound, whereas the systematic
silver concentration in the rest of the body was very low
and therefore completely unproblematic. These are very
positive findings that show that the silver ions are released
by aap's special coating and essentially only appear where
they are actually supposed to act.”

Prof. Dr. Dr. Volker Alt, Director of the Clinic for Trauma
Surgery at the University Hospital Regensburg
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Antibacterial Silver Coating Business

Attractive region Asia

Asian countries respond very positive on aap’s silver coating project. China and Vietnam are the first, showing great interest in this technology.

aap's trauma portfolio is newly
registered in China, but as an importer.
To rejoin the tenders the registration
should be switched to a local affiliate.

In 2020 Youshi Medical joined aap as
an investor which opens new
opportunities with China.

Approval strategy for China for the antibacterial silver-
coated product portfolio is based on the approach of
applying for an innovative patent. Patent’s not older
than two years and show novelty quality, it qualifies
for “fast” track.

A patent submission has taken place in China and EU
and is under evaluation through patent authorities.

Targets:

» Switch the registered trauma
portfolio to aap China affiliate

» Have the silver coating registered
with NMPA

> Roll-out Silver in SEA

aap Implantate AG
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Antibacterial Silver Coating Business uu

Attractive region USA

The US shows great interest. Bottleneck to continue the started FDA process is the wish of FDA to have an animal study. Therefore, the US is for
the time being on hold till data of the German human study can be used for further discussion with FDA. Restart FDA meetings estimated by end of

2024 with available study data.

Target:

» FDA approved silver trauma

aap has its full trauma portfolio FDA
portfolio

registered in US and has growing
access to facilities, today > 6.000,
including GPOs, IHNs, academy
contracts (veteran owned), others...

» Silver implants will become a must
for listings with GPOs, IHN and
other clinic groups but
prospectively also the US Military

Approval strategy for the antibacterial silver-coated product portfolio is
based on the approach of using the data of the German human study
and to avoid an animal study.

aap Implantate AG 27
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Antibacterial Silver Coating Business

Value creation potential

Trauma application exclusive for aap usage ->
gear up aap’s market share through aap’s silver
trauma line becoming the new gold standard.

Sales price for coated products
estimated mark-up +15% - +50%
compared to non coated products.
Final strategy fixing after ending of the
human clinical study and the launch of
the product.

“When this coating has its MDR approval, it has
the potential to become the new gold standard in
the trauma field.” states a coordinating
investigator of the human aap silver coating study.

COGS

Based on current production
process estimated between
+5% - +15% compared to non
coated products.

Patent lifetime EU 2030, US 2034, first market
product in trauma expected in 2026, depending
on MDR. New patents in evaluation.

Even after expiration of the patent lifetime high
protection due to complex production and
regulatory process.

Portfolio of aap trauma products
converted to silver trauma portfolio
estimated between 20% - 50% up to
potential 100%, to be decided later and
depending on regulatory path

aap Implantate AG
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Resorbable Magnesium Implant Business

Resorbable magnesium screws with clear economic benefits

New Age:
v
v
v
v
v
Avoid second operation v
and shorten the follow
up duration
v

Resorbable Magnesium Implants by aap

Innovative degradable product avoids a second surgery and results in a
much shorter follow-up (control intervals for the healing process) due to
its degradation and new bone formation for up to one-year healing
process.

Minimal surgery time required to perform a one-time short surgery.
Future implants are aimed for essential human mobility of foot and
hands.

Successful non-GLP study performed at Colorado State University (CSU).
Broad patent protection in place.
Typical application is screws in the small and micro-fracture market.

FDA granted “DeNovo” pathway. Assessed the technology as likely to
meet definition of “novel technology”, which is a strategic benefit.
According to the FDA, up to date there is no existing predicate which
can answer a metal degradation need.

aap plans to partner to co-finance a GLP study at CSU.

» Highly innovative technology also with game-changing potential

(valued with € 0.- in aap’s balance sheet)

aap Implantate AG
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Resorbable Magnesium Implant Business

Pilot non-GLP animal study in the US indicates superiority of technology

MicroCT Analysis after 6 weeks

v" Good bone contact and no
significant gas formation

Coated Un-coated Titanium Pin
Magnesium Pin Magnesium Pin

MicroCT Analysis after 6, 12, 24 weeks

no 5|gn|f|cant gas formation

After 12 weeks: Good bone contact
and no significant gas formation

After 24 weeks: Controllable
resorption process and good bone
growth ("proof of concept")

Coated Magnesium Coated Magnesium Coated Magnesium
Pin after 6 weeks Pin after 12 weeks Pin after 24 weeks

aap Implantate AG
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Resorbable Magnesium Implant Business

Product launch path for resorbable magnesium

Clinical study, pre- | IDE clinical trial

Al orior st Pre-clinical / animal
v g ru:r ske;s _ study pre-submissio e,
ntrac y - Q3/2019 y X + 1 year

=

FDA submission
X + 3 years

FDA pre submission meeting took place end of December
2019
» Regulatory clearance path was essentially agreed with
FDA
» FDA confirmed “De Novo Submission Path”
» Accelerated approval procedure for new
products (= no existent predicate device)
» Joint discussion of study design of pre-clinical-GLP
animal study
» FDA identified product to likely meet definition of
“Novel Technology”

according to schedule | v On track |
a) . a) 65-75 days FDA a) 65-75 days FDA a) 30days FDA a)
b) .. HEMIEW) review review
<) b) FDA meeting and b) FDA meeting and b) Approval b)
feedback in feedback
Q4/2019
c)

120 days FDA
review

FDA will ask
questions during
review which stops
their review clock
FDA approval

Product launch

-

aap Implantate AG
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Financials

Investment opportunity — your chance

Participation in subscription right convertible bond transaction

v' Enabling aap to build sustainable and profitable trauma business with € 20m
sales and positive cash-flow by 2026

v' Combined with the unique LOQTEQ® technology becoming the first silver
coated trauma line in the market

v' Enabling aap to unlock the significant value potential of its game changing
Silver coating technology by keeping the trauma license with aap and open
the license to non-competing third parties in the MedTech industry

v' Have an option in Magnesium

"» Become part of an exciting investment opportunity at an attractive price level
with great value creation potential

aap Implantate AG
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Financials

Conditions capital measure

Participation in a subscription right convertible bond transaction

A\ Y VY YV V V VY VY VYV

vV VY

Issue of 2,625,091 shares (equals to 29% pre capital increase)

Nominal volume/ max inflow: EUR 2,703,843.73

Signing period: 2 weeks; expected from September 15 — September 29, 2023

All participating anchor shareholders and larger new investors shall sign up in the private placement (rump)

Exchange ratio: 3,42 : 1 (each 3.42 shares entitles the shareholder to subscribe for one bond with a nominal value of EUR 1.03)
Conversion price: EUR 1.03

Conversionrate: 1:1

Conversion by bondholders / exercise period: During the period of 14 days prior to and including 31 October, 31 January, 30 April and 31 July of
each year, commencing on the period of 14 days prior to 31 October 2024

Blocking period/ No-Call Period: one year from the issue date of the Notes; expected until October 6, 2024
Mandatory conversion date:

» Either at the end of the term on 6 October 2028, provided that the closing price of the aap share in XETRA trading on the Frankfurt Stock
Exchange on 5 October 2028 is at least EUR 1.03 or

» If the volume-weighted average price of the aap share with ISIN: DEODOOA3H2101 in XETRA trading on the Frankfurt Stock Exchange on at
least sixty (60) consecutive trading days reaches an amount of EUR 1.60

Interest rate: 6% p.a.
Maturity/Duration: October 6, 2028 / October 6, 2023 to October 6, 2028

Anti-dilution: In accordance with market standard for future capital measures, either by granting subscription rights, compensation payment or
adjustment of the conversion price (at the choice and discretion of the Executive Board)

Extraordinary termination: In the usual marketable scope aap Implantate AG
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Financials qqp
)

Conditions capital measure

Participation in a subscription right convertible bond transaction

>
>

Change of control: Early redemption at the option of the noteholders in the event of a change of control
Merger: Early redemption at the option of the noteholders in the event of a merger

Offer type: Subscription offer to existing shareholders with possibility for oversubscription. Bonds not subscribed for as a result of the subscription
offer will be to institutional investors in Germany and other European countries by way of a private placement, with the purchase price
corresponding to the subscription price.

Listing: Prior to the issuance of the mandatory convertible bonds, aap plans to apply for the inclusion of the mandatory convertible bonds in
trading on the Regulated Unofficial Market of the Frankfurt Stock Exchange.

Delivery of conversion shares: aap is currently not in the position to issue conversion shares that will be admitted to trading. aap intends to achieve
full admission of all shares issued under this bond on the basis of a securities prospectus in accordance with Regulation (EU) 2017/1129 no later
than before the expiry of a one-year lock-up period from the issue of the mandatory convertible bond.

Status: The obligations of aap under the notes shall rank at least pari passu with all other unsecured and unsubordinated obligations of the
company (Pari passu clause)

— aap Implantate AG 36



Financials

Attachment — Profit and Loss Statement

Profit & Loss Statement aap- Group

kEUR

Sales

Changesin inventories

Other own work capitalized

Total revenues ex grants

Other operating income

Cost of purchased materials and services
Personnel expenses

Other operating expenses

EBITDA

6M/2023 6M/2022 Diff
5.864 5.553 311
-22 209 -231
59 67 -8
5.901 5.829 72
355 687 -332
-718 -925 207
-3.611 -3.622 11
-2.954 -3.148 194
-1.027 -1.179 152

aap Implantate AG
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Financials

Attachment — Balance Sheet and Cash-Flow

Balance Sheet aap- Group

kEUR Jun 30/2023 Dec 31 /2022 Diff
Balance Sheet Total 21.127 20.228 899
Non-current assets 8.513 9.047 -534
Current assets 12.614 11.181 1.433
Non-current and current liabilities 6.920 7.401 -481
Equity 14.206 12.827 1.379
Equity ratio 67% 63% 4 pp.
Cash-Flow aap- Group
kEUR 6M/2023 6M/2022 Diff
Cash-Flow Operating -1.542 -1.319 -223
Cash-Flow Investment -140 -300 160
Cash-Flow Financing 2.847 -179 3.026
Jun 30/2023 Dec 31 /2022 Diff
Cash and cash equivalents 1.402 236 1.166
Net debt 1.516 2.989 -1.473

aap Implantate AG
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Key abbreviations

aap
Ag
ANVISA
B2B

BfArM
BMBF
bn
BRIC
BU
CAGR
CAPEX
CE
CEO
CFO
CFR
COO
CSuU
CT
CTO
DANN
DE
DTO
e/E

EBITDA
f

FDA
FTE

FY

GLP
GM

HA
HTO

three-dimensional

aap implantate AG

Argentum (silver)

Regulatory body for medical devices in Brazil
Business to business

Das Bundesinstitut fiir Arzneimittel und
Medizinprodukte

Bundesministerium fiir Bildung und Forschung
billion

Brasil, Russia, India, China

Business unit

Compound Annual Growth Rate

Capital Expenses

Conformity marking of European Union
Chief Executive Officer

Chief Financial Officer

Code of Federal Regulations (US)

Chief Operating Officer

Colorado State University

Computer tomography

Chief Technology Officer
Deoxyribonucleic acid

Germany (DEutschland)

Distal Femoral Osteotomy

estimate

Earnings before interest, taxes, depreciation and

amortization

forecast

Federal Drug Administration
Full time equivalent
Financial year

Good laboratory practice
Gross margin
Hydroxyapatite

High tibial osteotomy

IP
ISO

KPI

K-wire
Log
MDR
Mg

MIS
NMPA
oD
OPEX
PEO
PEO
Q1
am
R&D
ROI
RoW
SG&A
SMIT
SSI

usD
VA
VET
w/o
Y, yr
YE
ZMX
Zn

Aobrciaton

Half-year

Intellectual Property

International Standards Organization
kilo (thousand)

Key performane integator

Kirschner wire

Logaritm

Medical device regulation

Magnesium

Million

Minimally invasive surgery

Regulatory body for medical devices in China
Overdose

Operational expenditure

Plasma electrolytic oxidation

Plasma Electrolytic Oxidation (PEQ) process
Quarter 1 (January - March)

Quality managment

Research and development

Return on investment

Rest of world

Selling, general and administrative expense
South Korea, Mexico, Indonesia and Turkey
surgical site infections

US Dollar
Variable angle
Veterinary
Without

year

Year-end
Mg-Zn-Mn Alloys
Zinc

aap Implantate AG
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Thank you qq

aap: > 30 years of...

Great Service

Highest Quality

Excellent State of the Art

Training Research & Development

at the Berlin site
Safe Products

...and continuing committed to innovation

aap Implantate AG 40
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aap Implantate AG

Lorenzweg 5

12099 Berlin, Germany
Phone: +49 30 75019 -0
Fax: +49 30 75019 - 111
info@aap.de

Rubino Di Girolamo

Chairman of the Management Board / CEO
Phone: +49 (0)30 75019 - 170

Mobile: +49 (0)1729756012

Email: r.digirolamo@aap.de

Agnieszka Mierzejewska

Member of the Management Board/ COO
Phone: +49 (0)30 75019 - 129

Mobile: +49 (0)1729756004

Email: a.mierzejewska@aap.de

Marek Hahn

Member of the Management Board / CFO
Phone: +49 (0)30 75019 - 178

Mobile: +49 (0)1736292074

Email: m.hahn@aap.de

aap Implantate AG
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